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Using the Inspector
The Edit page Inspector, which is closed by default, is the central area for editing effects 
parameters relating to compositing, sizing, titling, transitions, generators, and effects of all 
kinds. Many of the instructions in this chapter require the use of the Inspector, which can be 
opened or closed by clicking the Inspector button at the far right of the Edit page toolbar, or by 
double-clicking a transition or generator in the Timeline. 

The Inspector displays different parameters depending on what you’ve selected in  
the Timeline; (left) parameters of a clip, (right) parameters of a title

The parameters displayed in the Inspector are those of the currently selected item in the 
Timeline. Changing the selection changes which parameters are displayed, and the parameters 
you edit in the Inspector only alter the currently selected clip. If multiple clips are selected, the 
Inspector displays and edits only the leftmost clip within the selection.
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Selection Follows Playhead
Ordinarily, it’s possible for the Inspector to show the parameters of a selected clip even when 
the playhead is over another clip. You can change this behavior by choosing Timeline > 
Selection Follows Playhead, which sets Resolve to always select whichever clip intersects the 
playhead in the Timeline. The result is that the Inspector always displays the parameters of the 
clip at the playhead, without you needing to do anything other than moving the playhead back 
and forth in the Timeline. 

If there are multiple superimposed clips intersecting the playhead all at once, the top-most 
video clip with an enabled auto-select control will be selected, thus exposing its parameters in 
the Inspector, and all other clips will be ignored.

Inspector Controls
Different clips in the Timeline expose different controls. For example, ordinary video clips 
expose Video and Audio panels, while text generators expose Title and Video panels. 
Whichever panels are exposed, parameters within each panel are organized into groups, with a 
title bar providing the name of that group, along with other controls that let you control all 
parameters within that group at the same time. 

Closed and open Inspector group controls

These controls include:

 � Enable button: A round white button to the left of the parameter group’s name lets you 
disable and re-enable every parameter within that group at once.

 � Parameter group title bar: Double-clicking the title bar of any group of parameters 
collapses or opens them. Even more exciting than that, Option-clicking the title bar of 
one parameter group collapses or opens all parameter groups at once.

 � Keyframe button: This button lets you add or remove keyframes at the position of 
the playhead to or from every single parameter within the group. When the button is 
highlighted orange, a keyframe is at the current position of the playhead. When it’s dark 
gray, there is no keyframe.

 � Reset button: Lets you reset all parameters within that group to their default settings.
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Using the Inspector to Adjust Multiple 
Clips at the Same Time
There’s an easy way to make adjustments to the Inspector parameters of multiple clips at the 
same time, without needing to use Paste Attributes (described later in this chapter). All you 
need to do is simultaneously select every clip you want to alter, and then modify the parameter 
in the Inspector that you want to change. As a result, every selected clip will be adjusted by the 
same amount.

When you select multiple clips, the Inspector will display “Multiple Clips” as the title. If each of the 
selected clips have different values in the parameter you’re adjusting, that parameter will have 
two dashes in the value field. There are two ways you can make adjustments to multiple clips:

 � If you want to make a relative adjustment to all selected clips while keeping their 
original offsets from one another, then drag the virtual slider in the parameter field 
which will display a + or – before however many units your adjustment is. 

 � However, if you want to set all selected clips to the same value, you can double-click in 
the number field, type the value, and press Return.

Making a relative adjustment of plus 4.9 in  
the Rotation Angle of all selected clips

Adding Titles
There’s a collection of titles and generators in the Toolbox that you can use to create leader 
when outputting to tape, add slates, create subtitles, and otherwise fulfill any textual needs your 
program has.

Titles and generators can be edited much like any other clip. Furthermore, when selected, both 
titles and generators expose the same Composite, Transform, and Cropping parameter groups 
as any other clip; these parameters can be used to composite titles and fly them around in 
order to create different text effects. 

The available titles in the toolbox
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Methods of adding and editing generators and titles:

 � To drag and drop a generator directly into the Timeline: If you simply drag and drop 
titles or generators into the Timeline, the default duration of the resulting clip is 5 
seconds. This duration can be customized in the Edit panel of the Project Settings.

 � To edit a generator using the edit overlays of the Timeline Viewer: Click the 
destination control of the clip you want to edit a generator into, then set Timeline In and 
Out points to define the duration of the resulting edit, and drag the generator you want 
to edit onto the edit overlay of the Timeline Viewer that corresponds to the type of edit 
you want to perform.

 � To reposition the text of a title in the Timeline Viewer: Select the title generator you 
want to edit in the Timeline, then click the visible text in the Timeline Viewer so that 
its bounding box is selected; in this state you can reposition, scale, and rotate the 
text item.

 � To edit the text of a title in the Timeline Viewer: Select the title generator you want to 
edit in the Timeline, then double-click the visible text in the Timeline Viewer to insert 
a text editing cursor. At this point, you can select, delete, or add any text you want by 
typing directly in the Timeline Viewer.

 � To edit the parameters of a generator or title: Open the Inspector, and select the 
generator or title you want to edit to open it into the Inspector.

Using Safe Area Overlays
If you’re working on a broadcast program and you want to adhere to guidelines for title safe and 
broadcast safe, you can choose to display overlays that indicate where these regions are in the 
Edit page. 

To do so, choose View > Safe Area > Master On/Off. 

The available safe area overlays

If necessary, there are a number of ways you can customize this overlay by choosing one of the 
other options in the View > Safe Area submenu to toggle specific parts of the Safe Area overlay 
on and off. 
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These options include:

 � Extents: An outline showing the exact outer edge of the frame. Especially useful when 
the safe markers are set to an aspect ratio other than that currently used by the Viewer.

 � Action: An outline showing the outer 90% action safe area of the frame.

 � Title: An outline showing the outer 80% title safe area of the frame.

 � Center: A crosshairs showing the center of the frame.

 � Aspect: Enables use of the View > Select Aspect Ratio submenu to change the aspect 
ratio of the safe area markers. You can choose among the following aspect ratios: 1.33 
(a.k.a. 4:3), 1.66, 1.77 (a.k.a. 16:9), 1.85, and 2.35.

Types of Title Generators
When opened into the Inspector, titles expose a set of text parameters that allow you to style 
the contents of that clip’s Text field within the Inspector. Each of the titles supports rich text, so 
you can individually style words, lines, or paragraphs of text using the available parameters 
including Color, Font, and Size. Other attributes such as Alignment, Anchor, Position, and 
Shadow affect the entire title.

The following titles are available:

 � Simple: Useful for creating titles consisting of one word, line, or paragraph of text. A 
single body of text shares one set of rich text controls.

 � Scroll: Automatically automates a scrolling title sequence from the bottom to the top of 
the screen. The duration of the generator clip in the Timeline determines the speed of 
the scroll. Identical parameters as the Simple title.

 � L Lower 3rd: Automatically positions two lines of text at the bottom left corner of title 
safe, each with a different set of rich text and Position/Zoom/Rotation controls for 
independent sizing and animating.

 � M Lower 3rd: Automatically positions two lines of text at the bottom middle of title 
safe, each with a different set of rich text and Position/Zoom/Rotation controls for 
independent sizing and animating.

 � R Lower 3rd: Automatically positions two lines of text at the bottom right corner of 
title safe, each with a different set of rich text and Position/Zoom/Rotation controls for 
independent sizing and animating.

Title Generator Panels
The parameters of text generators are divided into two panels: the Title panel and the 
Video panel. 

 � The Title panel contains all of the text editing, styling, and sizing controls used to edit 
the contents and look of a title in your project, including the Rich Text, Drop Shadow, 
Stroke, and Background parameters.

 � The Video panel contains the same Composite, Transform, and Cropping parameters 
that all other clips in DaVinci Resolve have. These parameters are intended for 
compositing and animating a title.

Shared Title Generator Parameters
The title generators in Resolve are all capable of rich text styling, meaning that you can select 
any portion of a generator’s text and style it differently. For example, you could have three lines 
of text within a single generator, and style each line individually to create a particular design. 
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A single generator with three lines of differently styled text

Each title generator shares the same parameters in the Title panel of the Inspector for editing 
and styling text:

 � Rich Text: A control group consisting of a text entry field and parameters that can be 
used to style different parts of the text independently.

 � Text: A text entry field for editing the title being generated. If no characters are 
selected, the styling controls affect the entire block of text. If you select a specific set 
of characters, the styling controls only affect the selection. Text in this field can also 
be edited directly in the Timeline Viewer.

 � Font family: A pop-up for choosing one of the font families installed on your 
workstation.

 � Font face: A pop-up for choosing which face of the font family currently 
selected to use.

 � Color: Opens the standard color picker for choosing a font color.

 � Size: Slider for choosing the text size.

 � Tracking: Slider that sets the spacing between characters.

 � Line spacing: Slider for setting the spacing between the selected line of text and the 
next one below.

 � Font style: Buttons to apply underline, overhead line, strikethrough, superscript, and 
subscript styling.

 � Font case: A pop-up for forcing the text selection to be Mixed Case (the default), 
All Caps, All Lowercase, Small Caps, or Title Caps.

 � Alignment: Buttons to select the method of alignment: left, centered, right, or 
justified.

 � Anchor: Buttons for selecting how text is anchored to the current position, both 
horizontally (top, centered, bottom) and vertically (right, centered, left).

 � Position: X and Y parameters determining the bottom left-hand corner (the default 
Anchor settings) of the rich text block being generated. Corresponds to the act of 
dragging a selected text box in the Timeline Viewer.

 � Zoom: X and Y parameters determining the scale of the text. A link button lets you 
keep the X and Y parameters locked together. Corresponds to the act of resizing 
a selected text box in the Timeline Viewer from either the corners (to resize 
proportionally), or the top/bottom/sides (to stretch or squeeze the text).

 � Rotation: A slider for rotating the orientation of the text. Corresponds to the act of 
rotating a selected text box in the Timeline Viewer using the rotation handle.

 � Drop shadow: A group of controls that lets you apply a customizable drop shadow to 
every character of text being generated.

 � Color: Opens the standard color picker for choosing a drop shadow color.
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 � Offset: X and Y parameters determining how offset the drop shadow is from the 
original text.

 � Blur: A slider for blurring the drop shadow.

 � Opacity: A slider determining how transparent the drop shadow is.

 � Stroke: Lets you add an outline to every character of text being generated.

 � Color: Opens the standard color picker for choosing the stroke color.

 � Size: A slider lets you choose the thickness of the stroke, in pixels.

 � Background: This group of controls provides an extremely flexible rectangle or 
rounded rectangle shape that you can use to add a background, bar, outline, or other 
intersecting shape to use when designing a title.

 � Color: Opens the standard color picker for choosing the interior color of the 
background shape.

 � Outline color: Opens the standard color picker for choosing outline color of the 
background shape.

 � Outline width: A slider lets you choose the thickness of the background shape 
outline, in pixels.

 � Width: A slider lets you choose how wide to make the background shape.

 � Height: A slider lets you choose how tall to make the background shape.

 � Corner radius: A slider lets you choose the roundness of the rectangle edges.

 � Center: X and Y parameters you can use to offset the background shape from the 
text being generated.

 � Opacity: A slider lets you set the transparency of the background shape.

Title Generator Video Parameters
Additionally, each generator has Composite, Transform, and Cropping parameters in the Video 
panel of the Inspector that let you composite, resize, and animate titles against other clips in the 
Timeline for motion graphics effects. These parameters are the same as those available for 
every clip, as described later in this chapter.

Saving Titles in the Media Pool for Future Use
If you’ve created a title in a style that you want to later re-use, for example, a particularly-formatted 
lower third that will be the basis for every lower-third in your program, you can drag any title 
from the Timeline to the Media Pool, and it will be saved as a separate clip. Title clips in the Media 
Pool are shown with a thumbnail showing a preview of the text they contain. If you’ve keyframed 
any animated text or video adjustments, those keyframes are also saved with this clip.

A text generator saved as a clip in the Media Pool

Once saved in the Media Pool, text generators can be opened in the Source Viewer and edited 
just like any other clip.
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Using Generators
Generators, with the exception of Solid Color, lack editable parameters with the exception of 
the Composite, Transform, and Cropping parameters that are standard for every clip. 
Additionally, Generators have a Display Name field in the Inspector that lets you give a 
particular clip a custom name that appears in the Timeline.

The following generators are available:

 � Gray Scale: A simple grayscale ramp from black to white.

 � EBU Color Bar: A 1.77:1 aspect ratio set of color bars for PAL-using countries.

 � SMPTE Color Bar: An updated 1.77:1 aspect ratio set of color bars for NTSC-using 
countries.

 � 10 Step: A grayscale ramp segmented into 10 steps from black to white.

 � 100mV Steps: A grayscale ramp segmented into segments of exactly 100mV each.

 � Window: A simple white on black shape generator, defaulting to a white rectangle 
against a black background.

 � YCbCr Ramp: A gradient designed to test the Y’CbCr signal.

 � Solid Color: A simple fullscreen color generator. A Color parameter lets you choose 
what color this generator outputs.

Using Stills
You can import still images into the Media Pool, and edit them into the Timeline as clips with 
custom durations. By default, imported stills are 10 seconds long, but you can extend a still 
image’s Out point to a maximum of 17 hours and 40 minutes in length, which ought to cover just 
about any project you’re planning on working on, so long as you’re not Andy Warhol. DaVinci 
Resolve is correspondingly capable of importing still image clips referenced by XML or AAF 
project files, so long as they’re in a supported format. 

DaVinci Resolve supports the use of stills in the following formats:

File Format Alpha Channel Support

.tif Yes

.png Yes

.jpg No

.dpx No

.exr Yes

.dng No

.psd No

Once edited into the Timeline, still image clips have the same Composite, Transform, Cropping, 
Retime and Scaling attributes as any other clip.

Photoshop File Support
Only the bitmapped layers of Photoshop (.psd) files appear within DaVinci Resolve as a single 
clip in the Timeline. Photoshop text layers and layer effects are not supported.
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Composite Modes and 
Transparency Effects
Composite modes are effects that use various mathematical operations to combine one 
superimposed clip with another, relying on standard image processing math for each color 
channel whereby black pixels have a value of 0, white pixels have a value of 1, and descending 
levels of gray are represented by decimal point values (for instance, 0.5 represents 50% gray). 
When using composite modes to blend two clips together on the Timeline, the three color 
channels of each pair of pixels are combined using that particular composite mode’s math. The 
results can create transparency effects, increase image exposure, and combine multiple images 
in many creative and useful ways.

Two source clips combined with the Hardlight composite mode

When using composite modes, it’s easy to push parts of the resulting image above the 
maximum or below the minimum values for brightness. However, this image data is not clipped, 
even through such areas of the picture may appear flat white or black. Out-of-range data as a 
result of a composite mode effect is preserved, and may be retrieved by later image processing 
operations in the Color page.

When you import XML project files, Resolve imports whatever composite modes were used by 
clips in the original sequence. If necessary, you can then change a clip’s composite mode to 
one that will work better with whatever grade you’re creating. Of course, you can also add 
composite modes to clips that didn’t originally have them, adding new effects of your own. 

All composite modes interact with the Opacity slider (found below the Composite Mode pop-up 
menu in the Inspector) to make a clip more or less transparent in addition to compositing 
already being done.
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Composite modes can be used on clips that are superimposed over other clips in the Timeline. 
However, these composite modes are also available for use within a grade on the Color page 
using the Layer Mixer node, within which you can combine differently graded versions of an 
image in creative ways. For example, the Add and Overlay composite modes can be useful for 
creating glow effects, while Subtract and Difference can create more surreal effects.

Working with composite modes in the Edit page is simple.

To set or change a composite mode for any clip:

Select a clip in the Timeline, then open the Inspector and choose one of the options from the 
Composite Mode pop-up menu.

Composite mode and Opacity controls in the Timeline

To turn a clip’s composite mode off:

 � Select a clip in the Timeline, then open the Inspector and choose Normal from the 
Composite Mode pop-up menu.

More About Composite Modes
There are ten composite modes to choose from. For clarity, simple image math is used to help 
explain the available Composite Mode effects.

Normal
No image compositing is done. The topmost image on the Timeline or the bottom input of the 
Layer Mixer node occupies the entire frame.

Add
Each pair of pixels in both superimposed layers is added together. Layer order does not matter. 
This can result in a dramatic brightening of light areas of both images with areas of the picture 
that are blown out to maximum white, and this effect is often used by adding the brighter part of 
an image to itself to create hot glow effects. Image data going above 1.0 is preserved and may 
be retrieved by later color correction operations. On the other hand, black areas of either image 
do not alter the combined image at all (0 + n = n).

Color
Recombines two layers using HSL image components by combining the Luma of the bottom 
layer with the Hue and Saturation of the top layer.

Color Burn
Inverts the bottom layer, which is divided by the top layer, and the end result is itself inverted.

Color Dodge
The bottom layer pixels are divided by the top layer, which has been inverted.
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Darken
Each pair of pixels in each color channel is compared, and the darker of the two is the output. 
Layer order does not matter. Darken is useful when you want the darker features of both layers 
to take precedence, but the output for any given pixel may be a color that doesn’t actually exist 
for that pixel in either of the source layers.

Darker Color
For each pair of pixels, all three color channels from the bottom layer are added together, and 
all three color channels from the top layer are added together. These results are compared, and 
the darker pixel of the two layers is the output. Layer order does not matter. Darker Color is 
useful when you want the darker features of both layers to take precedence. Unlike the Darken 
composite mode, the result will always be a specific color from either the bottom or top layers.

Difference
The absolute value is taken of the top layer minus the bottom layer, and returned as the result, 
which is always a positive number. Layer order does not matter. This Blend mode is often used 
to compare two differently-processed versions of the same image to see if there are any 
alterations, and how large they are.

Divide
Divides the bottom layer by the top layer. Any color divided by itself = 1.0, or white, while any 
color divided by white (1.0) = itself.

Exclusion
Similar to the Difference composite mode, but results in lower contrast.

Hard Mix
The R, G, and B channel values of the bottom layer are added to the R, G, and B channel values 
of the top layer. Layer order does not matter. Can result in extreme effects.

Hardlight
Hardlight is the opposite of Overlay. All bottom layer pixels above 50% are Multiplied, while all 
bottom layer pixels 50% and below are Screened.

Hue
Recombines two layers using HSL image components, by combining the Luma and Saturation 
of the bottom layer, with the Hue of the top layer.

Lighten
Each pair of pixels in each color channel is compared, and the lighter of the two is the output. 
Layer order does not matter. Lighten is useful when you want the lightest features of both layers 
to take precedence, but the output for any given pixel may be a color that doesn’t actually exist 
for that pixel in either of the source layers.

Lighter Color
For each pair of pixels, all three color channels from the bottom layer are added together, and 
all three color channels from the top layer are added together. These results are compared, and 
the lighter pixel of the two layers is the output. Layer order does not matter. Lighten Color is 
useful when you want the lighter features of both layers to take precedence. Unlike the Lighten 
composite mode, the result will always be a specific color from either the bottom or top layers.
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Linear Burn
Each pair of pixels is summed, and 1 is subtracted from the total. Layer order does not matter. 
Regions of white in one layer let the other layer show through, while colors and darker tones 
from both layers interact to tint or darken the resulting image.

Linear Dodge
Each pair of pixels is summed. This composite mode is identical to Add.

Linear Light
All regions where the bottom layer is above 50% are Linear Dodged so as to lighten these parts 
of the final result, while all regions where the bottom layer is below 50% are Linear Burned so 
as to darken these parts of the final result. This composite mode intensifies image contrast in 
the final result.

Luminosity
Recombines two layers using HSL image components by combining the Hue and Saturation of 
the bottom layer with the Luma of the top layer.

Multiply
Each pair of pixels is multiplied together. Layer order does not matter. This generally has the 
effect of emphasizing the darkest parts of both images in the resulting output; in particular 
black areas of either image are preserved (0 * n = 0) while white areas of either image have no 
effect on the output image (1 * n = n). Multiply is good for compositing darker elements in a field 
of white into an image, and can be used to emphasize the darkest parts of a noise, grain, or 
damage layer you’re blending with an image.

Overlay
Overlay combines useful aspects of both the Screen and Multiply composite modes, based on 
the pixel values of the bottom-most image on the Timeline; all bottom layer pixels above 50% 
are Screened, while all bottom layer pixels 50% and below are Multiplied. Overlay is an 
excellent composite mode for combining a layer of noise, grain, or damage imagery with 
another clip, as it combines both images in visually useful ways throughout the tonal range of 
shadows through highlights.

Pin Light
In regions where bottom layer pixels are below 50% gray, lighter pixels in the top layer are 
replaced by darker pixels from the bottom layer, and darker pixels in the top layer replace 
lighter pixels in the bottom layer, so that the darker half of the final image combines darker 
pixels from both layers. In regions where bottom layer pixels are above 50% gray, darker pixels 
in the top layer are replaced by lighter pixels from the bottom layer, and lighter pixels in the top 
layer replace darker pixels from the bottom layer, so that the brighter half of the final image 
combines lighter pixels from both layers.

Saturation
Recombines two layers using HSL image components, by combining the Luma and Hue of the 
bottom layer, with the Saturation of the top layer.

Screen
The pixel values of each layer are inverted, then multiplied, and the result is itself inverted. 
Layer order does not matter. Screen is the inverse of Multiply, as it preserves the lightest parts 
of both images, and is useful when compositing lighter elements in a field of black into an 
image, and can be used to emphasize the lightest parts of a noise, grain, or damage layer 
you’re blending with an image.
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Softlight
A less intense method of applying the Hardlight composite mode that results in a more even 
blend between the two layers.

Subtract
Within each pair of pixels, those of the bottom layer are subtracted from those of the top. This 
can result in dark areas of the image that hit flat black, but image data going below 0 is 
preserved and may be retrieved by later color correction operations.

Vivid Light
All regions where the bottom layer is above 50% are Color Dodged so as to lighten these parts 
of the final result, while all regions where the bottom layer is below 50% are Color Burned so as 
to darken these parts of the final result. This composite mode vastly intensifies both image 
contrast and saturation in the final result, for an extreme effect.

Unknown
When importing XML or AAF project files with composite modes that aren’t available in Resolve, 
the Composite Mode pop-up menu is set to Unknown; practically, this is the same as Normal.

Opacity
Each clip has an Opacity parameter, available in the Inspector, that lets you make it more 
transparent, in a range from 0 (totally transparent) to 100 (totally opaque). When set to a value 
less then 100, the selected clip is mixed with whatever clip is  underneath it on the Timeline, 
according to the composite mode that’s currently used. If no clip appears underneath the 
Timeline, then the clip is mixed with black.

By keyframing this parameter, you can create more complicated fade to black effects or 
cross-dissolves. Keyframing is covered in more detail later in this chapter.

To change a clip’s opacity:

 � Open the Inspector, then select the clip you want to adjust, and set the Opacity slider 
to create the desired amount of transparency.

Video Fader Handles
If you want to dissolve a clip to or from another clip, or to or from black, the traditional way to do 
so has been to use one of the transitions in the Effects Library. However, you can also use 
Fader Handles that appear at the beginning and end a clip when you position the pointer right 
over it. Fader handles are a fast, ubiquitous method of creating a fade to or from black. 
However, they also make it easy to fade to or from other clips that are underneath one that’s 
superimposed, as seen in the following screenshot.

Dragging a video fader handle on a clip in track V2
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To use a fader handle, move the pointer over the clip you want to adjust, and when small green 
fader handles appear at the upper left and upper right of the video of the clip, drag them to the 
left or right for the duration you want the fade effect to last.

Alpha Channel Support
If a superimposed video or still image clip in the Timeline has an embedded alpha channel, that 
alpha channel automatically creates transparency within that clip, compositing it against 
whatever is in the track underneath. There’s no need for you to do anything for this to work. 

Superimposing a clip with an alpha channel above automatically 
composites that clip against the clip beneath it

However, if you want to disable the alpha channel for any clip, for example if a clip is being 
interpreted as having an alpha channel incorrectly, you can use the Find in Media Pool 
command to select that clip in the Media Pool, where you can right-click it and choose Change 
Alpha Mode > None.

NOTE: If you’ve imported clips with Alpha channels, those alpha channels can be 
rendered back out for Round Trip workflows if you set Render to Individual Clips in the 
Deliver page, choose a Format and Codec combination that supports alpha channel 
output, and turn on the Export Alpha checkbox in the Video panel of the Render 
Settings list.
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Keying, External Mattes, 
and Window Compositing
It’s also possible to use the Qualifier, Power Window controls, and External Matte clips in the 
Color page to create compositing effects by connecting a key that you create to the optional 
Alpha Output that can be added to the Node Editor. In this way, you can pull a simple 
greenscreen key using a qualifier, do rotoscoping or matte work using a Power Window, or use 
an External Matte to composite two or more clips together, and see these effects on the 
Edit page.

For more information on the use of the Alpha Output to do node-based compositing, see 
Chapter 30, “Working in the Node Editor.”

Transform, Cropping, and Lens Correction
DaVinci Resolve is a resolution-independent application. This means that, whatever the 
resolution of your source media, it can be output at whatever other resolution you like. This also 
means that you can freely mix clips of any resolution, fitting 4K, HD, and SD clips into the same 
timeline, and scaling each to fit the project resolution as necessary.

Your project’s resolution can be changed at any time, allowing you to work at one resolution, 
and then output at another resolution. This also makes it easy to output multiple versions of a 
program at different resolutions, for example, outputting both HD and SD sized versions of the 
same program.

DaVinci Resolve has a powerful tool set for making geometric transforms, using advanced 
algorithms for optical-quality sizing operations. Within the Edit page, each clip has a set of 
transform parameters, principally for use in storing sizing data imported from AAF or XML when 
you turn on the “Use sizing information” checkbox. This has the advantage of keeping these 
imported Edit Transform settings separate from the Input Sizing parameters found on the Color 
page, which are typically used by the colorist to make Pan and Scan adjustments of 
various kinds.

Of course, you can also use these controls to create your own adjustments while working in the 
Timeline, zooming into clips, repositioning them to improve the composition, etcetera. While 
there is some overlap between these parameters and those in the sizing palette of the Color 
page, they’re both separate sets of parameters, so you can keep each set of adjustments 
separate. 

When the time comes to output your program, the final resolution of each clip is calculated 
taking into account the original resolution of the source media, the timeline resolution, image 
scaling settings, Edit page transforms, and Color page transforms, so that the final resolution 
correctly uses the cleanest geometric transformation based on the maximum resolution 
available to each source clip.
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The Edit page transform group includes the following parameters, which are also editable in 
the Edit Sizing mode of the Sizing palette in the Color page:

 � Position X and Y: Moves the image within the frame, allowing pan and scan 
adjustments to be made. X moves the image left or right, and Y moves the image 
up or down.

 � Zoom X and Y: Allows you to blow the image up or shrink it down. The X and Y 
parameters can be linked to lock the aspect ratio of the image, or released to stretch or 
squeeze the image in one direction only.

 � Rotation Angle: Rotates the image around the anchor point.

 � Anchor Point X and Y: Defines the coordinate on that clip about which all transforms 
are centered. When using the on-screen controls, you can Option-drag the center 
handle to move the anchor point anywhere you want.

 � Pitch: Rotates the image toward or away from the camera along an axis running through 
the center of the image, from left to right. Positive values push the top of the image 
away and bring the bottom of the image forward. Negative values bring the top of the 
image forward and push the bottom of the image away. Higher values stretch the image 
more extremely.

 � Yaw: Rotates the image toward or away from the camera along an axis running through 
the center of the image from top to bottom. Positive values bring the left of the image 
forward and push the right of the image away. Negative values push the left of the 
image away and push the right of the image forward. Higher values stretch the image 
more extremely.

 � Flip Image: Two buttons let you flip the image in different dimensions.

 � Flip Horizontal control: Reverses the image along the X axis, left to right.

 � Flip Vertical control: Reverses the clip along the Y axis, turning it upside down.

The Edit page has an additional set of cropping parameters:

 � Crop Left, Right, Top, and Bottom: Lets you cut off, in pixels, the four sides of 
the image. Cropping a clip creates transparency, so that whatever is underneath 
shows through.

 � Softness: Lets you blur the edges of a crop. Setting this to a negative value softens the 
edges inside of the crop box, while setting this to a positive value softens the edges 
outside of the crop box.

The Dynamic Zoom controls, which are off by default, make it fast and easy to do pan and scan 
effects to zoom into or out of a clip. Also, if you import a project from Final Cut Pro X with clips 
that use the Ken Burns effect, then those clip’s effects will populate the Dynamic Zoom 
parameters in DaVinci Resolve. Turning the Dynamic Zoom group on activates two controls in 
the Inspector that work hand-in-hand with the Dynamic Zoom on-screen adjustment controls 
you can expose in the Timeline Viewer (described below):

 � Dynamic Zoom Center: Lets you choose how the motion created by these controls 
accelerates. You can choose from Linear, Ease In, Ease Out, and Ease In and Out.

 � Swap: This button reverses the start and end transforms that create the dynamic 
zoom effect.
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The Retime and Scaling group has one parameter that affects clip scale, and another that 
affects retiming quality:

 � Retime Process: Lets you choose a default method of processing clips in mixed frame 
rate timelines and those with speed effects (fast forward or slow motion) applied to 
them, on a clip by clip basis. The default setting is Project Settings, so that all speed 
effected clips are treated the same way. There are three options: Nearest, Frame 
Blend, and Optical Flow, which are explained in more detail in the Frame Interpolation 
section of Chapter 3, “Project Settings and Preferences.”

 � Scaling: Lets you choose how clips that don’t match the current project resolution 
are handled on a clip by clip basis. The default setting is Project Settings, so that all 
mismatched clips use the same method of being automatically resized. However, you 
can also choose an individual method of automatic scaling for any clip. The options 
are Crop, Fit, Fill, and Stretch, which are explained in more detail in the 2D Transforms 
section of Chapter 29, “Color Page Effects.”

 � Finally, the Lens Correction group (only available in Resolve Studio) has two controls 
that let you correct for lens distortion in the image, or add lens distortion of your own.

 � Analyze: Automatically analyzes the frame in the Timeline at the position of the 
playhead for edges that are being distorted by wide angle lens. Clicking the Analyze 
button moves the Distortion slider to provide an automatic correction.

 � Distortion: Dragging this slider to the right lets you manually apply a warp to the image 
that lets you straighten the bent areas of the picture that can be caused by wide angle 
lenses. If you clicked the Analyze button and the result was an overcorrection, then 
dragging this slider to the left lets you back off of the automatic adjustment until the 
image looks correct.

Transform, Cropping, and Dynamic 
Zoom Using Graphical Controls
You also have the option of transforming, cropping, or adding dynamic zoom effects to clips 
using the Transform/Crop/Dynamic Zoom button at the bottom left of the Timeline Viewer.

Transform controls in the Timeline Viewer

To transform a clip using graphical controls in the Timeline Viewer:

1 Click the the Transform/Crop button at the bottom left of the Timeline Viewer to turn it 
on; white is enabled, gray is disabled. 

2 Do one of the following:

 � Choose the Transform mode from the pop-up menu, if necessary, to change modes. 
The appropriate on-screen controls appear to let you manipulate the clip with the 
mouse. When in Transform mode, you can drag anywhere within the clip’s bounding 
box to adjust pan and tilt, drag any diagonal corner to proportionally resize, drag any 
side to squeeze or stretch just width or height, or drag the center handle to rotate.
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Onscreen controls for transforming in the Timeline Viewer

 � Choose the Cropping mode from the pop-up menu. In this mode, each side has a 
handle for cropping.

Onscreen controls for cropping in the Timeline Viewer

 � Choose the Dynamic Zoom mode from the pop-up menu. In this mode, the green 
box shows the starting size and position of the animated transform, while the red 
box shows the ending size and position of the animated transform. Drag anywhere 
within either bounding box to adjust pan and tilt for either the start or the end of 
the animated effect, and drag any of the corners to adjust the size. A motion path 
appears to show the motion that’s being created.
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Onscreen controls for transforming and cropping in the Timeline Viewer

3 If necessary, choose a smaller viewing percentage from the Timeline Viewer scale pop-
up to better see the on-screen controls if you’re rescaling the image, or use the scroll 
control of your mouse, trackpad, or tablet to zoom out of the image.

4 When you’re finished, turn the Transform/Crop/Dynamic Zoom button off.

Speed Effects and Retiming
Speed effects describe any effect that speeds up, slows down, or otherwise changes the 
playback speed of clips in the Timeline. There are four basic ways you can create speed effects 
in DaVinci Resolve.

 � Importing speed effects: DaVinci Resolve is capable of reading linear speed effects 
from imported EDL, AAF, and XML projects, and nonlinear speed effects from XML and 
AAF project files. When speed effects are present, Resolve plays clips at the specified 
speed. You can also create speed effects of your own using controls in the Edit page. 
There are three methods of adjusting clip speed: using the Inspector, using the Change 
Speed dialog, and using the Retiming effect in the Timeline.

 � Creating speed effects using Fit to Fill edits: You can also change a clip’s speed in the 
Timeline by editing it using the Fit to Fill command, which retimes the clip to fit into an 
arbitrary duration in the Timeline of your choosing. For more information on using Fit to 
Fill, see the section on “Different Types of Edits” in Chapter 14, “Editing Fundamentals.”

 � Creating simple linear speed effects: You can create simple fast or slow-motion 
speed effects by using the Change Clip Speed command, or by using the left and right 
handles of the Retime controls in the Timeline. Both of these methods are described in 
this section.

 � Creating variable speed effects: You can create much more complex variable speed 
effects, where the same clip speeds up or slows down multiple times by different 
amounts, using either the Retime controls, or one of the two different speed curves that 
are available. These methods are also covered later in this section.
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Creating Simple Speed Effects
If all you need to do is to make a clip play in slow motion, speed it up, reverse the clip, or create 
a freeze frame, you can apply a simple speed effect using either the browser or the Change 
Speed dialog.

To change a clip’s speed, do one of the following:

 � Select a clip, choose Clip > Change Clip Speed, and use the controls of the Edit Speed 
Change dialog.

 � Right-click a clip in the Timeline, choose Change Clip Speed, and use the controls of 
the Edit Speed Change dialog.

Speed Clip Change operations have the following options:

 � Change Speed To parameters: Changes the speed of the selected clip by whatever 
percentage, frame rate, or duration you like.

 � Ripple Sequence checkbox: If you want the speed change you’re about to make 
to ripple the Timeline, pushing or pulling all clips following the current one to 
accommodate the clip’s new size, then turn on the checkbox.

Speed effect parameters shown in the Speed dialog

 � Reverse Speed button: Clicking this button sets the current speed to a negative value, 
reversing the motion of the clip.

Speed Effects and Audio

Any of the methods of creating linear speed effects that are available in Resolve, 
including the Change Clip Speed command, the Retime controls, and the Fit to Fill 
edit, will retime a clip’s audio, without pitch correction on Linux and Windows, and with 
pitch correction on Mac OS X (Yosemite and above), along with its video. However, 
audio that accompanies variable speed effects will be muted.
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 � Freeze Current Frame checkbox: Changes the entire clip to a freeze frame of 
whichever frame is at the current position of the playhead.

 � Maintain Timing/Stretch to fit radio buttons: Choosing Maintain Timing leaves any 
keyframes within the clip locked at their original position, while choosing Stretch 
Keyframes results in all Composite, Transform, and Cropping keyframes being 
compressed or stretched by the same percentage as the clip during a speed change.

Clip Retiming Controls
Another method of altering clip speed in the Timeline is to apply the Retime effect. This method 
of clip retiming provides a convenient control overlay that you can use to adjust clip speed 
directly in the Timeline, and it also provides the controls that are needed for creating variable-
speed effects.

To expose the Retime controls on a clip:

 � Select a clip, and choose Clip  > Retime Clip (Command-R).

 � Right-click a clip and choose Retime Clip from the contextual menu.

The Retime controls appear over that clip in the Timeline. They consist of a Retime control track 
running along the top of the clip with arrows that indicate the speed and direction of playback 
(the default blue right-facing arrows indicate normal 100% playback) and a Clip Speed pop-up 
menu at the bottom center of the clip, which also shows the current speed  of the clip.

The Speed Effect controls in the Timeline

Retiming An Entire Clip
The simplest way of using the Retiming effect is to change the playback speed of the entire clip, 
in the process rippling the rest of the Timeline to the right of the retimed clip as you increase its 
duration by stretching or compressing its duration.

To retime a clip by dragging:

 � Move the pointer to the left or right edge of the Speed Change name bar on top of the 
clip, and when it turns into a Retime cursor, drag either side to stretch or squeeze the 
clip to retime it.

To retime a clip by specific amounts:

1 Select a clip and press Command-R.

2 Click the pop-up next to the speed percentage text at the bottom of the clip.

3 Do one of the following:

 � Choose a new playback speed from the Change Speed submenu.

 � Choose reverse segment to make the clip play in reverse. Reverse speed is shown in 
the Retime control track as arrows facing left, instead of right.



435Chapter 19 – Edit Page Effects

To return a clip to its original speed:

 � Click the pop-up next to the speed percentage text at the bottom of the clip, and 
choose Reset to 100%.

Rippling or Overwriting the Timeline When Using Retime
Whether or not clips to the right in the the Timeline will ripple to accommodate the change in 
duration resulting in speed changes you make with the Retime controls depends on whether 
you’re using the Selection tool/mode (in which case the Timeline won’t ripple), or the Trim tool/
mode (in which case the Timeline will).

Reading Clip Speed Arrows
When you retime a clip, the Clip Speed pop-up menu displays the current speed of the entire 
clip. Additionally, the arrows in the Retime control track show you the speed and direction of 
playback. When clip speed is slowed down below 100%, the Retime control track shows blue 
playback triangles that are spaced farther apart. When clip speed is sped up above 100%, the 
Retime control track shows blue triangles that are bunched closer together. At 100% normal 
speed, the Retime control track shows blue, evenly spaced triangles, while left-facing blue 
arrows indicates reverse playback.

Three clips set to different speeds. From left to right, 100% speed, slow motion,  
and fast forward are indicated by the yellow arrows.

Creating Variable Speed Effects Using the Retime Controls 
You can also use the Retime controls to insert freeze frames within the middle of a clip, and 
create other custom variable speed effects using speed points. Additional variable speed 
options include rewind and speed ramp effects, which automatically place speed points to 
create preset effects.

To create a freeze frame at a particular moment in time:

1 With the Retime controls exposed, move the playhead to the frame you want to freeze, 
within that clip. Ideally, this will be for an effect where you want a character in motion to 
suddenly stop at a particular frame.

2 Open the Clip Speed pop-up menu, and choose Freeze Frame. Two new speed points 
are added to the clip, defining a range within which the clip is frozen at that frame. This 
can be seen by the vertical red bars in the retime control track. Past the second speed 
point, the clip resumes playback from the next frame forward.
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Speed effect controls set to insert a momentary freeze frame within the clip

3 Drag the second speed point forward or back to define the duration of the freeze 
frame. The result is that the clip plays normally up until the first speed point, then 
freezes on that frame until the second speed point, at which playback resumes.

To create variable-speed effects:

1 With the Retime controls exposed, move the playhead to the frame at which you want 
to change the speed of the clip, and choose Add Speed Point from the Clip Speed 
pop-up menu.

2 Move the playhead forward to the next frame at which you want the clip speed to 
change again, and add another speed point. It takes a minimum of two speed points to 
create a speed effect.

3 To alter the speed of the clip segment appearing between these two speed points, do 
one of the following:

Using the pointer, drag the top handle of the second speed point to the right to slow 
down clip playback, or to the left to speed up clip playback within just that segment. 
Doing this either shortens or lengthens the clip, and either overwrites or ripples 
neighboring clips depending on whether you’re using the Selection or Trim modes.

Also using the pointer, you can drag the bottom handle of any speed point to widen the 
range of the clip that plays at that particular speed. Doing this reallocates frames from 
before and after the speed segment being adjusted to keep all speed segments 
playing at the same speed, and this also shortens or lengthens the clip, but by a 
different amount.

4 To clear a speed point and eliminate that particular clip’s speed segment from the 
effect, choose Clear Speed Point from any Clip Speed pop-up menu to eliminate 
whichever speed point appears to its left.

When you create variable-speed effects, the arrows in the Retime control track can help you 
keep track of what you’re doing, and each segment’s speed pop-up shows you the actual 
numeric speed. The change in speed from each speed segment to the next is automatically 
eased, for a smooth transition from one speed to another.

Speed controls set to ramp among three different  
playback speeds; arrow spacing shows the timing
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There are two additional sets of commands for creating preset speed effects that use multiple 
speed points.

To add a rewind effect:

 � With a clip’s retime controls exposed, open any Clip Speed pop-up menu and choose 
a preset percentage from the Rewind submenu. This results in two additional speed 
points being added after the rightmost speed point in the current segment, which 
creates the effect of the current segment playing in fast reverse for the chosen 
percentage, and then playing a second time from the beginning.

Speed effect controls before and after creating a “rewind” effect

To add a speed ramp:

 � With a clip’s retime controls exposed, open any Clip Speed pop-up menu and choose 
one of the two options from the Speed Ramp submenu to replace the current speed 
effect with a series of five speed segments that start at 10% and increase progressively 
to 30%, 50%, 70%, and then 90%. Once created, you can drag the speed points to 
customize this effect to create whatever durations you require.

Speed effect controls set to create a gradual ramp from 0 to 100 percent playback speed
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Closing Retime Controls
When you’re finished creating your Retime effect, you can close the Retime controls so that clip 
assumes a normal appearance again. Closing the Retime controls has no effect on the timing of 
the clip, it just ensures you cannot accidentally modify the speed of the clip with the mouse.

To close the Retiming controls in the Timeline:

 � Click the X button at the upper left-hand corner of the Retime control box.

 � Select the retimed clip, and either choose Clip > Retime Controls, or press Command-R.

When a retimed clip has its Retiming controls hidden, a Retime badge appears to the left of that 
clip’s name in the Timeline. You can reopen the Retiming controls whenever you need to make 
further changes.

The Speed Effect badge that  
shows a clip is being retimed

To reopen the Retiming controls in the Timeline:

 � Select the retimed clip, and either choose Clip > Retime Controls, or press Command-R.

Once you’ve retimed a clip using the Retime effect, you can use that clip’s Retime Process 
parameter in the Inspector to define how that clip’s retiming is processed, using the low quality 
Nearest option, using Frame Blending, or using Optical Flow. 

Using Retime Curves
You can also optionally use curves to retime clips, either in conjunction with the Retime 
controls, or by themselves. For example, you can use the simpler retiming controls first to create 
the overall speed effect you need, and then use the Retime Curves to create further 
refinements by adjusting bezier curve handles to adjust speed transition points, or you can 
expose a Retime Curve first and use it to create your speed effect from scratch by adding and 
adjusting control points and curve segments. 

 

The Retime Curves let you adjust the transition  from one speed to another using handles
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No matter how you like to work, the control points of speed curves have a 1:1 correspondence 
to the speed points that are exposed in the Retime Controls, and curve segment modifications 
are mirrored by speed point adjustments in the Retime Controls if you have both exposed at the 
same time. This means that, when creating complex variable retiming effects, it’s easy to drag 
whichever control most easily adjusts the quality of speed you require.

In addition, there are two kinds of Retime Curves you can use for maximum flexibility. Which is 
best depends on what you’re more comfortable with, and on which will handle the type of 
motion you want to create more easily:

 � The Retime Frame curve exposes a diagonal line that represents a time graph. This 
is a type of curve found in many other postproduction applications, in which the 
vertical axis represents each frame of that clip’s source media, and the horizontal axis 
represents each frame of playback in the Timeline. With the default diagonal graph, 
there is a one to one correspondence between each frame of source media and each 
frame of timeline playback; this represents 100% speed. However, adding control points 
lets you alter how source frames are mapped to the Timeline. For any two control 
points on the Retime Frame curve, so long as the control point at the left is lower than 
the control point at right of a curve segment, there will be forward motion, with longer 
shallow curve segments creating slower motion, and steeper shorter curve segments 
creating faster motion in the clip. 

 

A diagonal Retime Frame curve with two segments: a long shallow segment to theleft that  
creates slow motion, and a short steep segment to the right that creates fast motion

 � If a curve segment has a left control point that’s higher than the right control point, then 
the motion will be reversed and that segment will play backwards.
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A Retime Frame curve with an inverted curve that creates reverse motion

 � The Retime Speed curve (seen below) exposes a flat line that represents 100% speed. 
Adding pairs of control points and dragging each segment to raise or lower it alters 
speed; you must drag the segments, not the control points themselves. Raising a curve 
segment shortens that segment and speeds up that portion of the clip, while lowering 
a curve segment lengthens that segment and slows down that portion of the clip. As 
you adjust each curve segment, a tooltip shows you the exact speed percentage that 
segment represents. You should note that it’s impossible to create reverse motion using 
the Retime Position curve; you need to use either the Retime controls or the Retime 
Speed curve described above.

 

A Retime Speed curve with two segments: a shorter one that creates  
fast motion, and a longer segment that creates slow motion
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Methods of working with speed curves:

 � To expose speed curves for a clip in the Timeline: Right-click a clip in the Timeline, and 
choose Retime Curve. The Curve Editor is exposed for that clip, and you can edit it as 
you would any other curve, adding moving, and deleting control points.

 � To switch between editing Retime Speed and Retime Frame curves: Use the Curve 
pop-up at the upper left-hand corner of the Curve Editor to check or uncheck the 
curves you want to be visible. Clicking on a curve within the editor makes that curve the 
currently edited one.

 � To close a speed curve: Clicking the Curve button at the right-hand side of the clip’s 
title bar in the Timeline toggles the curve open and closed.

As far as adding, removing, and smoothing control points on speed curves and adjusting curve 
segments, they work identically to any other curve in the Timeline. For more information, see 
“Keyframing in the Timeline and Curve Editor” later in this chapter.

Speed Effect Processing
Once you’ve retimed a clip, you have the additional ability to change how the retimed clip is 
processed in order to improve its visual playback quality, especially in the case of clips that are 
slowed down. There are two ways you can set this. First, there’s a project-wide setting available 
in the Master Project Settings. Secondly, you can change how clips are retimed via a per-clip 
setting available in the Inspector.

To change the Retime Process setting of an entire project:

1 Open the Project Settings to the Editing panel.

2 Choose an option from the Retime Process pop-up menu.

To change an individual clip’s Retime Process setting:

 � Select a clip, then open the Inspector and choose an option from the Retime Process 
pop-up in the Retime and Scaling group.

Keyframing Effects in the Edit Page
Most parameters in the Inspector of the Edit page can be keyframed, in order to create 
animated effects such as zooming in via the Zoom parameter, fading out via the Opacity 
parameter, or cropping from one side to reveal a clip underneath via the Cropping parameters. 
Additionally, if you import a project from an NLE that has keyframed sizing settings, those 
keyframes will be imported and exposed within the Edit page of Resolve.

The primary controls for keyframing are within the Inspector. Any parameter that can be 
keyframed has a gray keyframe button to the right of its slider. If the playhead is on a keyframe, 
this button turns orange and small  navigation arrows appear to its right and left, otherwise it 
stays gray. 

Orange Keyframe buttons in the Inspector  
show there’s a keyframe at that frame
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Once you’ve keyframed one or more parameters within a particular group in the Inspector, that 
clip displays a pair of small buttons at the far right of its name bar in the Timeline, a Curve 
button and a Keyframe button. Only keyframed clips have these buttons.

 

The Keyframe track button in the  
Timeline appearing on a keyframed clip

Clicking the Keyframe button exposes the keyframe tracks for that clip. Each group of 
parameters in the Inspector reveals a single, aggregated keyframe track, that holds all the 
keyframes of all the parameters within that group, and makes it easy to move, delete, cut, copy, 
and paste keyframes for each clip. For example, the Pan, Tilt, Zoom, Rotation Angle, and Anchor 
Point keyframes all appear within the Transform track.

A keyframe track for all of the Transform group parameters

If you want to edit each parameter independently, a small disclosure control at the right of each 
keyframe track lets you open up an aggregated keyframe track into individual keyframe tracks, 
one for each parameter that’s been keyframed within that group of Inspector controls.

Clicking a keyframe track’s disclosure control reveals individual 
 keyframe tracks for each keyframed parameter in the Inspector
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Additionally, each keyframed clip has a Curve button that, when clicked, exposes that 
parameter within a Curve Editor that’s attached to the clip in the Timeline.  

A clip’s Curve Editor button, used to open  
the Curve Editor for that particular clip

Multiple parameters can be opened within the Curve Editor at the same time, and you can 
choose which curve to work on by clicking it in the Curve Editor, or clicking one of that 
parameter’s keyframes in the keyframe track above. Selected control points can be moved, and 
their bezier interpolation changed using one of the four buttons located at the top of the 
Curve Editor.

Keyframing in the Inspector
Keyframing in the Edit page works slightly differently than when using the Keyframe Editor in 
the Color page. Most simple keyframing tasks can be performed in the Inspector using three 
buttons that appear to the right of any parameter that’s capable of being keyframed.

 

The three keyframe controls that appear in the Inspector, from left to right: 
Previous keyframe, Create/Delete keyframe, Next keyframe

Methods of keyframing parameters in the Inspector:

 � To add a keyframe: Select a clip, open the Inspector, then move the Timeline playhead 
to the frame where you want to place a keyframe, and click the Keyframe button next 
to the parameter of the Inspector you want to animate. Once you’ve added at least 
one keyframe to a parameter, all other adjustments you make to parameters in the 
Inspector, or using the on-screen Transform/Crop controls in the Timeline Viewer add 
new keyframes automatically if the playhead is at another frame.

 � To move the playhead to the next or previous keyframe: Right-Bracket ( [ ) and Left-
Bracket ( ] ). You can also click the small left- or right-hand arrow to either side of a 
parameter’s keyframe control to jump the playhead to the next or previous keyframe.

 � To edit an existing keyframe of a parameter: Move the playhead to be on top of the 
keyframe you want to edit, and then change that parameter, either in the Inspector, or 
using the on-screen controls of the Timeline Viewer.

 � To delete a single keyframe: Open the Inspector, move the Timeline playhead to 
a frame with a keyframe, and click the orange Keyframe button in the Inspector to 
delete it.

 � To delete all keyframes for one parameter: Click the reset button to the right of a 
parameter’s keyframe control in the Inspector.

 � To delete all keyframes in a group of parameters in the Inspector: Click the reset 
button to the right of a parameter group’s title bar in the Inspector.
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 � To disable or enable a single parameter’s keyframed effect: Click the white dot at the 
left of a parameter’s keyframe track in the Timeline. White means that track’s enabled. 
Gray is disabled.

 � To disable or enable a group of parameters in the Inspector: Click the white dot at the 
left of a parameter group’s title bar in the Inspector. White means that group is enabled. 
Gray is disabled.

Keyframing Motion Paths in the Timeline Viewer
If you’re keyframing a clip’s transform controls to create motion, a motion path appears when 
you turn on the onscreen transform controls using the button to the left of the 
transport controls.

A visible motion path resulting from animated Position X and Y parameters

Each keyframed change to the Position X and Y parameters creates a control point on the 
surface of the motion path, which is linear by default, creating a sharp edge. However, you can 
right-click any control point and choose Smooth from the contextual menu to add bezier 
handles to that control point, which let you change the sharp angle to an adjustable curve.

 

Changing the linear control point into a bezier curve

The control points making up any motion path can be dragged around at will to change the 
path the selected clip will travel. Dots on the surface of the motion path indicate the velocity of 
motion; dots that are closer together indicate slower motion, while dots that are farther apart 
indicate faster motion. Dragging a motion path control point farther away from another one will 
speed up the animation between both points, while dragging it closer will slow the animation 
down, as you’re setting up the selected clip to travel a longer or shorter distance within the 
same keyframed time.
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Dots on the motion path show that the left half has slow motion,  
while the right half has faster motion

You can also adjust the shape of any control point’s curve by clicking to select that control 
point, which exposes its bezier handles, and then dragging the handles to adjust its curve. 
Once handles have been exposed, there are a variety of methods you can use to adjust them 
and manipulate the motion path.

Finally, you can adjust the acceleration of motion by adjusting the Acceleration handle on the 
stem of any Bezier curve. Dragging an acceleration handle towards a control point creates an 
eased keyframe, where motion slows to a stop, or begins from a stop. Dragging an acceleration 
handle away from a control point creates more linear motion, where the object moves 
continuously through that control point.

 

An acceleration handle on the Bezier handle of a curve lets you create eased 
motion by dragging it in towards the control point being adjusted
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Methods of adjusting the bezier handles of motion paths:

 � Drag any control point to reshape the motion path.

 � Drag any bezier handle to change the shape of the curve.

 � Command-drag any bezier handle to break the tangent between it and the opposite 
bezier handle. When you release the Command key, the two bezier handles become 
locked together again at whatever angle you created.

To eliminate a control point on a motion path, along with its keyframe:

 � Right-click any control point and choose Delete Keyframe.

To switch a control point between sharp and curved angles:

 � Right click any control point and choose Linear (for a sharp angle) or Smooth 
(for a curve).

Keyframing in the Timeline and Curve Editor
If you need to do more complicated keyframing than the relatively simple controls of the 
Inspector allow, you can use the Keyframe tracks and Curve Editor found in the Timeline.

The Keyframe Editor
When one or more clip parameters are keyframed, two small buttons appear at the far right of a 
clip’s name bar in the Timeline, a Curve button and a Keyframe button. Clicking the Keyframe 
button opens the Keyframe Editor, exposing one keyframe track for each group of parameters 
that’s keyframed. For example, the Composite parameters, Transform parameters, and 
Cropping parameters are all encapsulated by group tracks.

The Keyframe track button in the  
Timeline appearing on a keyframed clip

For example, if you’d added keyframes to the Zoom and Position parameters, these keyframes 
all appear within a single keyframe track labeled Transform, while Opacity adjustments appear 
on a second keyframe track for Composite.

Group keyframe tracks open in the Timeline
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However, each group keyframe track has a disclosure button that lets you show or hide each 
individual parameter that’s keyframed within that group. For example, clicking the Transform 
keyframe track’s disclosure button shows the Zoom and Position tracks, so you can adjust 
those individual keyframes.

 

Individual parameter keyframe tracks open in the Timeline

These keyframe tracks let you edit keyframes in context of the actual clip durations in the 
Timeline. Click the small Keyframe button at the bottom right of the clip’s name bar to close the 
keyframe tracks when you’re finished.

Methods of adjusting keyframes in the Keyframe Editor of the Edit Page:

 � To add new keyframes to the Keyframe Editor: Option-click anywhere on a track of the 
Keyframe Editor to add a new keyframe, which defaults to whatever the current value is 
for that parameter at that frame.

 � To select one or more keyframes in the Keyframe Editor: Click a single keyframe to 
select it, or drag a bounding-box around multiple keyframes to select them all at once.

 � To move one or more control points: Select one or more control points and drag left or 
right. While you drag keyframes, a tooltip appears showing you the offset in frames of 
your adjustment from the beginning of that clip’s source media. If you’re only dragging 
one keyframe, the tooltip also shows you the name of the parameter you’re modifying.

 � To nudge selected keyframes one frame at a time: Select one or more keyframes and 
use the left and right arrow keys to nudge them back and forth, for precision editing.

 � To delete one or more control points: Select the keyframe(s) you want to delete and 
press Backspace.

 � To disable or re-enable an entire track of keyframes: Click the white button at the far 
left of each keyframe track; it turns gray to show that track has been disabled.

 � To cut, copy, and paste one or more keyframes: Make a selection of keyframes, 
and use the Cut (Command-X) or Copy (Command-C) key shortcuts. Then, move the 
playhead to where you want the first of the pasted keyframes to start, and press Paste 
(Command-V).

 � To duplicate one or more keyframes: Make a selection of keyframes, then hold the 
Option key down and drag the selected keyframes to duplicate them and move the 
duplicates to a new position.

The Curve Editor
If you want to work with keyframes in even more detail, you can click the small Curve Editor 
button at the far right of a clip’s name bar. The Curve Editor can be opened in addition to the 
Keyframe Editor, or it can be opened in isolation.
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The Curve Editor open in the Timeline

You can open multiple parameters into the Curve Editor using the curve pop-up menu at the 
upper left-hand corner of the Curve Editor that lets you choose which parameters are exposed 
via checkboxes. This menu also lets you choose which curve is selected by clicking the name 
of the parameter you want to edit.

 

Choosing which parameters to  
display in the Curve Editor
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While you can only work on one curve at a time, you can choose which curve is selected to 
edit. Using the control points exposed by each curve, you can edit parameters, alter keyframe 
timing, and change each control point’s interpolation to create custom easing effects affecting 
the acceleration of change from one keyframe to the next.

Methods of keyframing parameters in the Curve Editor of the Edit page:

 � To switch which curve you’re editing: If the Keyframe Editor is open at the same 
time as the Curve Editor, you can click the keyframe track you want to edit and the 
corresponding curve will be highlighted. Otherwise, click the curve pop-up menu at 
the upper left-hand corner of the Curve Editor, and choose which curves you want to 
expose to work on. If multiple curves are open in the Curve Editor, click the curve you 
want to edit to highlight it for editing.

 � To select one or more keyframes: Click a single keyframe to select it, Command-
click multiple keyframes to select them one at a time, or drag a bounding-box around 
multiple keyframes to select them all at once.

 � To drag one or more control points on a curve: Select one or more control points and 
drag left or right to retime them, and up or down to change their value. Hold the Shift 
key to constrain keyframe adjustment in only one direction.

 � To nudge selected keyframes one value or frame at a time: Select one or more 
keyframes and Command-Left Arrow and Command-Right Arrow to nudge them in 
time, or Command-Up Arrow and Command-Down Arrow to nudge their value, for 
precision keyframe adjustments.

 � To add a new control point to a curve: Option-click anywhere on a curve to add a new 
control point.

 � To delete one or more control points from a curve: Select the keyframe(s) you want to 
delete and press Backspace.

 � To cut, copy, and paste one or more keyframes: Make a selection of keyframes, 
and use the Cut (Command-X) or Copy (Command-C) key shortcuts. Then, move the 
playhead to where you want the first of the pasted keyframes to start, and press Paste 
(Command-V).

 � To change the interpolation of a control point: Click the control point you want to edit 
to select it, and then click one of the four bezier interpolation buttons in the Curve 
Editor title bar.

 � To adjust a bezier handle: Drag the bezier handle in any direction to alter the curve.

The Curve Editor with bezier interpolated keyframes

When you’re finished working with the Curve Editor:

 � Click the Curve Editor button at the bottom right of the clip’s name bar to close the 
Curve Editor.
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Paste Attributes
You can copy and paste attributes from one clip to multiple clips using the Paste Attributes 
command. This is a fast way to apply video and audio adjustments and effects from one clip to 
many others in the Timeline.

To copy attributes:

1 Select a clip with attributes you want to apply to other clips, and press Command-C.

2 Select one or more other clips to paste to.

3 Choose Edit > Paste Attributes (Option-V). 

4 When the Paste Attributes window appears, click the checkboxes of each of the 
attributes you want to paste, and click Apply when you’re done.

The Paste Attributes window

The Paste Attributes window shows you the clip you’re copying from and the clip(s) you’re 
pasting to at the top, and provides checkboxes you can use to select which attributes you’d like 
to paste. A pop-up menu below lets you choose how you’d like to apply any keyframes that are 
part of the attributes being pasted; the options are Maintain Timing or Stretch-to-Fit.
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Fusion Connect
For instances where the various effects in the Edit and Color page aren’t enough to achieve the 
effect you require, you can use the Fusion Connect features of DaVinci Resolve to send one or 
more clips from the Edit page timeline to Blackmagic Fusion, in order to do more robust 
compositing and effects work there. You can use this workflow in the Mac OS, Windows, and 
Linux versions of Resolve, since Fusion works on all three platforms. This is a simple round-trip 
operation that lets you send clips from the Resolve timeline to Fusion, add effects, and then 
render a finished effect out of Fusion that will automatically appear back in your timeline.

Using Fusion Connect
Sending one or more clips to Fusion is simple.

To send clips to Fusion:

1 Select one or more clips in the Timeline that you want to send to Fusion. In this 
example, two superimposed clips are selected.

Selecting two clips to send to Fusion

2 Right-click one of the selected clips and choose New Fusion Connect Clip from the 
contextual menu.

3 In the New Fusion Connect Clip dialog, choose the following options:

a. Enter a name.

b. Choose a video format (for rendering media to send to Fusion).

c. Choose a codec, based on the format you selected.

d. If you want to save the Fusion Connect Clip that you’re creating, along with its 
directory and media, to a specific location, turn on the Custom Location checkbox, 
then click the Browse button and choose a location. Otherwise, the directory 
containing the Fusion Connect clip and any source media rendered along with it is 
placed in the same directory as the scratch disk.

e. If you don’t want to render self-contained media with baked in effects and grading 
from Resolve, turn on the “Use source media for Fusion Connect clip” to create a 
Fusion Connect project that references the original media files on disk.



452Chapter 19 – Edit Page Effects

f. If you want to immediately open Fusion, turn on the “Open clip in Fusion” checkbox. 
If you do this, then Resolve by default renders each of the video clips you selected, 
along with every speed effect, transform, and Color page operation that’s been 
applied to each clip, using the Timeline Color Space. However, if you click Cancel 
when the Render Composition Media dialog appears, then the Fusion project that 
opens references the source media on disk, rather than rendered media that’s 
generated by Resolve.

 

The New Fusion Connect Clip dialog

4 When you’re finished, click Create. Resolve creates a Fusion Connect clip, which 
appears in the Timeline as a single clip, and in the Media Pool.

Fusion Connect clips in the Timeline

Fusion Connect clips in the Media Pool

5 Opening the Fusion Connect clip in Fusion can be done in one of two ways:

 � If you turned on “Open clip in Fusion,” then Fusion automatically opens and the clips 
you selected appear as Loader nodes within Fusion.

 � If you didn’t, then you can right-click the Fusion Connect clip in the Media Pool, and 
choose Fusion Connect > Open Fusion from the contextual menu.
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At this point, new media is rendered (by default), Fusion opens, and the clips you sent 
are converted into a Fusion node tree, explained in greater detail in the 
following section.

6 In Fusion, use the available tools to create the required effect.

7 Optionally, before you render, if you want to change the Output Format, click the 
Output node, and choose a new format from the Output Format popup in the Tools 
tab. If you don’t do this, the Fusion composite will be rendered using the format you 
selected when you sent the Fusion Connect clip in the first place.

 

The Tools panel where you can change the file  
information governing the rendered output

8 When you’re finished creating your effect in Fusion, click the Render button to open 
the Render Settings, check to make sure that the settings are correct, and click Start 
Render. This renders the Fusion composition to the disk location and using the name 
that you chose in step 3.  

 

Selecting two clips to send to Fusion

9 A Render Settings dialog appear, which lets you choose how you want to render the 
output, with options including the Quality, Frame Range, and Size of the media being 
output. If the default settings are good, click Start Render. A progress bar indicates how 
long the render will take. For more information, consult the Fusion User Manual.

10 Once rendering has finished, save your Fusion Project, reopen DaVinci Resolve, and 
you should see that the Fusion Connect clip in the Timeline has updated to show the 
new effect you created in Fusion.



454Chapter 19 – Edit Page Effects

How Clips are translated into Node Trees
In Fusion, each clip that you send appears as a Loader node that is linked to that clip’s media on 
disk. If you selected multiple clips, each clip is superimposed over the one just below it using a 
Merge node, which lets you merge two images at a time with an Over operator by default.

 

Two superimposed clips sent to Fusion as represented in the Fusion node tree

With this as your starting point, you can add nodes (called Tools in Fusion) to apply operations 
of your own, in order to create more sophisticated effects and composites. For more information 
about using Fusion, see the Fusion User Manual, available from the Support page at the 
Blackmagic Design web site.

Altering Fusion Connect Clips
If, at any point, you want to modify the Fusion composition, you can reopen the project in 
Fusion, or right-click the Fusion Connect clip in the Resolve Media Pool and choose Fusion 
Connect > Open in Fusion. Once in Fusion, make whatever changes you want to, and then 
re-render the clip to overwrite the previously rendered media. When you create new versions in 
this way, each version’s Fusion project file and rendered output is maintained and preserved, 
so you can always go back and forth.

When you return to Resolve, you may need to right-click the Fusion Connect clip you just 
opened, and choose Fusion Connect > Refresh to make sure that Resolve correctly sees the 
re-rendered media from Fusion.

Creating Multiple Versions of Fusion Clips
If you want to render a new version, but you want to keep the previous version, then you can 
right-click the Fusion Connect clip in the Resolve Media Pool and choose Fusion Connect > 
Create New Version. 

 

Creating a new version of a Fusion Connect composite
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This creates a duplicate of the composite in Fusion, with the “_v1” part of the file name 
incremented so it doesn’t overwrite the previous version of that composite. 

Once in Fusion, make whatever changes you need to the composite, then re-render the clip to 
generate an additional piece of media for that version. The Filename of the Saver node for the 
new media you’re rendering is also automatically incremented with the “_v1” segment of the 
filename changed to the next version number, such as “_v2” if it’s version two of the effect.

When you’re finished, you’ll end up with a Fusion Project file and a corresponding rendered media 
file that share the same version number. When you return to Resolve, Resolve will automatically 
detect that there are multiple versions in the Fusion Connect directory, and will make each 
version available via a Choose Version submenu for Fusion Connect clips in the Media Pool.

The Tools panel shows the Saver node’s updated  
Filename for the new version’s rendered output

Switching Versions of Fusion Connect Clips in Resolve

Once you’ve created multiple versions of a Fusion Connect clip, you can switch which version is 
used for that clip in Resolve by right-clicking the Fusion Connect clip in the Media Pool, and 
choosing the version from the Fusion Connect > Select Version submenu of the 
contextual menu.

Choosing which version to use from the Fusion Connect > Select Version submenu

TIP: If you want to switch versions for a Fusion Connect clip in a timeline, you can 
right-click that clip and choose Find in Media Pool.
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Sending a Fusion Connect Directory to Another Machine
If you’re going to hand off a Fusion Connect directory to someone else using a different 
workstation, it’s a good idea to render self-contained media for the Fusion composition to make 
it easy to hand off everything the compositing artist will need. Otherwise, you’ll need to 
manually find and provide the associated media files yourself. There are two ways of rendering 
self-contained media for Fusion:

 � If you check “Open Fusion Connect Clip” in the New Fusion Connect Clip dialog, then 
Resolve by default renders each of the video clips you selected, along with every 
speed effect, transform, and Color page operation that’s been applied to each clip, 
using the Timeline Color Space. 

 � If you haven’t opened the Fusion Connect clip in Fusion yet, you can also right-click any 
Fusion Connect clip in the Media Pool, and choose Fusion Connect > Render Media 
from the contextual menu.

Once that’s done, there are two ways you can locate the actual Fusion Connect directory’s 
location, in order to copy it for whomever is going to be doing the compositing work for you.

 � You can turn on the Custom Location checkbox in the New Fusion Connect Clip dialog, 
then click the Browse button and choose a location where the resulting directory is 
easily copied.

 � You can also right-click on any Fusion Connect clip in the Media Pool, and choose 
Reveal in Finder to open that Fusion Connect clip’s directory.

Since your Resolve project keeps track of the location of the Fusion Connect directory from the 
moment it’s created, you don’t want to move it, since Resolve is counting on it being where it 
thinks it is. Once your colleague has completed the compositing work in Fusion, all they need to 
do is send you back the Fusion Composition file ( just so you can keep everything together), 
and the media they rendered, both of which you need only copy to the top level of the 
corresponding Fusion Connect directory. Once you do that, Resolve should automatically see 
the rendered media and refresh those Fusion Connect clips on your timeline.

Creating Multiple Versions of Fusion Clips on Another Machine
If you’ve handed off the directory created by the Fusion connect process to someone off site, 
they can still create multiple versions of the composite that can be managed by 
DaVinci Resolve.

Use the Save As command in Fusion to save a duplicate of the Fusion project with the “_v1” 
segment of the filename incremented to the next version number, such as “_v2” if it’s version 
two of the composite. Make sure you save this duplicate Fusion project into the same directory 
as the original, so Resolve can find it. Once created, you can change this duplicate project file 
any way you need.

When you’re finished, select the Saver node (at the very end of the Fusion node tree), and 
change the Filename by incrementing the V1 part of the Filename field. What part of the file 
path you rename depends on whether you’re rendering to a file-based format, or a frame-based 
format. For example, if you’re rendering a QuickTime clip being named Output_V1.mov, then 
change the Filename to Output_V2.mov in the Tools tab, and render. If you’re rendering a DPX 
image sequence, then you’ll want to change the name of the folder that encloses the frames, so 
change the Filename from “…/fusion/OutputDirectory_V1/Output_00000000.dpx” to “…/fusion/
OutputDirectory_V2/Output_00000000.dpx” to obtain a correctly named second version.



457Chapter 19 – Edit Page Effects

Updating Fusion Connect Clips Using 
Render Media and Refresh
If you change a grade or effect that’s applied to a clip inside of a Fusion Connect clip, you’ll 
need to right-click that clip and choose Fusion Connect > Render Media to re-render updated 
media files for the Fusion project.

If you re-render a Fusion composite and overwrite media that’s already referenced by a Fusion 
Connect clip in an open DaVinci Resolve project, you may need to refresh that media reference 
in Resolve. The easy way to do this is to right-click any Fusion Connect clip in the Media Pool or 
Timeline, and choose Fusion Connect > Refresh.


